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Fluke Corporation
FlukeView® Forms License Agreement
BY USING THIS SOFTWARE PRODUCT IN ANY MANNER, YOU ARE AGREEING TO ACCEPT THE FOLLOWING
TERMS AND CONDITIONS.
Fluke Corporation (Fluke) grants you a non-exclusive right to use FlukeView Forms Documenting Software (Product) on a
single PC or workstation (node), or on multiple nodes, provided that a multi-use license is obtained from Fluke and the
number of nodes does not exceed the number of nodes for which license fees are paid. This grant of license does not include
the right to copy, modify, rent, lease, sell, transfer or distribute the Product or any portion thereof. You may not reverse
engineer, decompile, or disassemble the Product.
Fluke warrants that the Product will perform in its intended environment substantially in accordance with the accompanying
written materials for a period of 90 days from the date of license acceptance. Fluke does not warrant any downloading errors
or that the Product will be error free or operate without interruption.
FLUKE DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, BUT NOT LIMITED TO IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE
SOFTWARE AND THE ACCOMPANYING WRITTEN MATERIALS. In no event shall Fluke be liable for any damages
whatsoever (including, without limitation, indirect, consequential, or incidental damages, damages for loss of business profits,
business interruption, loss of business information, or other pecuniary loss) arising out of the use of or inability to use this
Product, even if Fluke has been advised of the possibility of such damages.
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Introduction

Contacting Fluke

FlukeView Forms Documenting Software lets you transfer
data from a supported digital test instrument directly to
forms on your computer. This automates your
troubleshooting or recording process, reduces the
possibility for manual error and allows you to collect,
organize and display meter data in a format that meets
your needs.

To order accessories, receive assistance, or locate the
nearest Fluke distributor or Service Center, call:
USA: 1-888-44-FLUKE (1-888-443-5853)
Canada: 1-800-36 FLUKE (1-800-363-5853)
Europe: +31 402-675-200
Japan: +81-3-3434-0181
Singapore: +65-738-5655
Anywhere in the world: +1-425-446-5500
Address correspondence to:
Fluke Corporation
Fluke Europe B.V.
P.O. Box 9090
P.O. Box 1186
Everett WA 98206-9090 5602 BD Eindhoven
USA
The Netherlands
Visit us on the World Wide Web at: www.fluke.com
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FlukeView Forms Documentation

FlukeView Features

The following documentation is available for use with
FlukeView Forms.

Acquires and documents readings from supported digital
meters through IR or standard serial communications.

Table 1. Documentation Sources
Documentation
Users Manual
Meter Connection
Pages

Format / Where
to Find
Adobe Acrobat /
Available on the
FlukeView
Forms CD, and
installed with the
software

Tutorials

Online Help

Technical Notes

2

Windows Help /
FlukeView
Forms Help
menu
Adobe Acrobat /
Available at
www.fluke.com
and on the
FlukeView
Forms CD

Use For
Basic operation
and overview
Step-by-step
instructions for
connecting each
type of meter
Step-by-step
instructions for
common tasks
On-the-spot
application help

Detailed
technical
information.

•

Displays acquired results in graphs and tables.

•

Allows you to save and print results.

•

Allows you to retrieve and view previously saved
results.

•

Allows real-time logging directly to a connected PC,
with meters that support interactive logging.

•

Allows you to transfer collected readings to other PC
applications.

•

Provides standard form templates to display results
professionally.

•

Includes FlukeView Forms Designer program for
creating customized form templates (not included in
FlukeView Forms Basic).

FlukeView Forms Basic
FlukeView Forms Basic is a less customizable version of
FlukeView Forms, designed to provide only basic data
communications and display capability. It contains a
subset of the features provided by the full FlukeView
Forms product, and can be used with only a limited
number of standard form templates.

Documenting Software
Installation

Installation

Overview of FlukeView Forms

This section describes how to install FlukeView Forms and
FlukeView Forms Designer. Also, follow these instructions
to upgrade from an older version of the software.

The Users Manual provides an overview of what you need
to know to use FlukeView Forms. This includes:
•

Starting FlukeView Forms

System Requirements

•

Selecting a form template

•

Transferring data from the meter to the PC

•

Managing forms to meet your needs

•

Saving and retrieving data

•

Exporting data

•

Managing your database

•

Troubleshooting

Operating System: Windows 2000, Windows XP or
Windows Vista.
Minimum recommended hardware: Pentium class
microprocessor, 32 MB RAM, and up to 70 MB hard disk
space (100 MB to install).
Note
To install the software on Windows 2000,
Windows XP, or Windows Vista, you must log in
with Administrator privileges.

Installing FlukeView Forms
To install FlukeView Forms, please see the printed
FlukeView Forms Installation Guide. For installation of the
Fluke USB-IR cable, see the USB-IR Cable Installation
Instructions.

Most users start FlukeView Forms, select a form template,
connect the meter to the PC, transfer data, add user data,
and then print and save the form. More advanced users
might spend time customizing form templates, retrieving
and exporting data, and managing the database.
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Figure 1. FlukeView Forms Screen
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Table 2. Graphic User Interface Components
No.

Description

A

Active form template. Displays meter data and user-entered data.

B

FlukeView Forms menu.

C

Select a form template drop-down list. Lists all form templates available in the open database. Identifies the active
template currently being displayed.

D

Saved forms drop-down list. Lists all forms you have saved with the active template. Displays the name of the saved form
you are viewing, or (untitled) if the form has not been saved.

E

Virtual Meter button. Opens the virtual meter window. The virtual meter displays the active meter readings and copies
single-readings to the active form. It also lists, summarizes, and exports uploaded data.

F

Designer launches the designer.

G

Get Meter Data button. Uploads data from meter memory and displays it in the active form.

H

Logging button. Begins set up and interactive logging from the meter. Displays logged data on the active form.

I

Find button. Helps you locate forms you have saved previously.

J

Clear, Save or Print the active form.

K

Meter connection icon tells you if a meter is connected and communicating with your FlukeView Forms software.
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Note

Starting FlukeView Forms

If you open a new blank form template,
FlukeView Forms asks if you want to save any
changes you have made to the current active
form.

To start FlukeView Forms:
1.

From the Windows taskbar, select Start, Programs,
Fluke, then FlukeView Forms.

2.

Click the FlukeView Forms menu item.

Selecting a Form Template
FlukeView Forms templates are designed to display data
in different ways. After you select the appropriate form
template, it becomes the active form. When you transfer
meter data, it displays in the active form.

FlukeView Forms provides general-purpose form
templates. See online tutorials for more information on
customizing form templates.

Getting Data from the Meter to the PC
The meter communicates with a PC through a USB or
serial cable. FlukeView Forms transfers meter data to the
PC three ways:

1.

On the File menu, select New Blank Form.

•

Upload data from meter memory

2.

A New Blank Form dialog box appears. Double-click
a form template name in the Select a form template
list.

•

Interactive logging

•

Single-reading copy to the active form

The type of meter you have determines which transfer
methods can be used.
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Table 3. Meter Communication Styles

How Your Meter Communicates Data
The following table shows how certain Fluke meters
communicate data to the PC, as well as the type of data
readings the meters support. See Logged Readings and
Display Readings later in this manual for additional details
about types of readings.

Fluke Meter
Model

Uploading

Interactive
Logging

87 IV / 187

Single-Reading
Copy to Form

L

D

L

D

89 IV / 189

L,D

Connecting the Serial Cable to a PC

53 / 54

L,D

1.

Attach the IR cable or standard serial cable to your
PC.

183 / 185

D

L

D

287/289

L,D

L

D

Attach the other end of the cable to the meter. For
more details or information on your specific meter,
see Meter Connection Pages on your CD.

45 / 8808A /
8846A

L

D

L

D

L

D

2.

Changing the Communications Port
The communications port that FlukeView Forms uses is
displayed at the bottom right of the FlukeView Forms
screen.
To change the communications port:
1.

Open FlukeView Forms.

2.

On the Tools menu, select Options. The Options
dialog box appears.

3.

Click the Communications tab.

4.

In the Port list, click the communications port you
want to use. The default communications port for
FlukeView Forms is COM1.

568

D

789
975

L,D

1653

D

1550B

D
‘L’ – Logged Readings / ‘D’ – Display Readings

Note
If a meter is not found in Table 3, then refer to
the meter’s users manual.
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Logged Readings and Display Readings
FlukeView Forms deals with two types of meter data,
logged readings and display readings. Refer to Table 3 to
determine the type of readings generated by your
meter(s).
Logged readings are taken during a logging session.
There are two ways to generate logged readings:
•

During interactive logging between a meter and a PC
running FlukeView Forms.

•

Some meters support logging directly to meter
memory. In this case, logged readings are stored in
meter memory and uploaded from meter memory to
FlukeView Forms at a later time.

Display readings are taken one at a time, as opposed to
being recorded during a logging session. Display readings
are transferred to FlukeView Forms two ways:
•

When you upload individually saved readings from
meter memory.

•

When you perform a single-reading copy to form.
Note
Readings stored in meter memory are identified
variously as saved readings, stored readings or
memory readings in the meter manuals.

8

Logged readings in a logging session always have the
same units. For example, results are all V ac, all V dc,
etc. However, display readings may be in different units.
Display readings are not graphed in FlukeView Forms,
but logged readings can be.
Note
FlukeView Forms treats readings from Fluke
53/54-II, 975, 983, 568 and 287/289 meters as
both logged readings and display readings.

Uploading Data
If your meter has memory, the meter can record data
without a PC present and store it in meter memory.
FlukeView Forms then uploads data from the meter
memory to the PC. Data storage on the meter is limited
by the meter memory.
Meters that support uploading data are listed on Table 3.

Documenting Software
Getting Data from the Meter to the PC
To upload data:

5.

1.

Start FlukeView Forms.

2.

Select the form template you want to use by opening
the File menu and selecting New Blank Form.
Highlight the form template in the New Blank Form
dialog box and click OK.

On the Meter menu, select Get Meter Data to upload
the meter data to the active form. The Get Meter
Data dialog box appears. In some cases, this step is
unnecessary. Instead, you are prompted with the Get
Meter Data dialog box automatically.
You can also press the Get Meter Data button to
access the dialog box.

3.

Connect the meter to the PC using the IR cable.

6.

4.

Turn the meter on.

Interactive Logging
Note

If your meter has a PC/IR SEND button, you must
use that button to initiate communication with the PC.

Data readings are copied directly into the active form.

In interactive logging, readings are logged directly from
the meter and stored on the PC. This allows FlukeView
Forms to take advantage of the PC’s larger memory while
connected to the PC during the logging session.
However, the meter must support interactive logging and
be either ac powered or have sufficient battery power to
run for the length of the logging session.
Meters that support interactive logging are listed on
Table 3.
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To begin interactive logging:

The Setup, Schedule and Status tabs of the Logging
Window display settings for and provide information
about the logging session. Use them to:

1.

Connect the meter to the PC.

2.

Select the form template you want to use by opening
the File menu and selecting New Blank Form.
Highlight the form template in the New Blank Form
dialog box and click OK.

•

Change the default logging settings under Setup.

•

Display Simulation Graph to examine the effects of
your logging settings on example data.

3.

On the meter, choose the meter function and range
you want to use to measure the input.

•

4.

In FlukeView Forms, click the Meter button at the top
right-hand portion of the toolbar. Use the virtual
meter to confirm that the meter readings are correct.

Manually Start and Stop a logging session, or set
scheduled Start/Stop times for a logging session
under the Schedule tab.

•

Examine the progress of the active logging session
under Status.

5.

From the Meter menu, select Logging. The Logging
Window appears. You can also press the Logging
button to access the Logging Window.

6.

Set up your logging session using the Setup tab of
the Logging Window (or make no changes to
Setup, and use the default configuration).

7.

Click Start or Stop to start or stop logging.
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Figure 2. Interval Events and Input Events
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Event Logging
During interactive logging, FlukeView Forms compresses
the input being measured by the meter into a series of
events. Each event is represented by a sample at the
start of the event, a duration, starting time, ending time,
and the highest, lowest and average values detected
during the event. The highest (max) and lowest (min)
readings include the timestamps when each were
detected. See the Graph View options (right click on the
graph) to view the samples on the events.

When you start logging, the meter readings are monitored
by FlukeView Forms and are classified by event type. The
two event types you will see most often are:
•

Input events are described as either stable or
unstable. Stable input events contain readings that
fall inside the user-defined settings. Unstable input
events contain readings that fall outside the userdefined settings. See Figure 2.

For a more detailed discussion of all types of events, see
the FlukeView Technical Notes, available on your CD.
Each event is stored in an individual logged reading.
Note
If your meter supports the display of two
readings at once, and both are being displayed,
then both readings may be logged, depending
on the settings you have selected.
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Input events are logged when the input reading
changes beyond the user-defined input event
settings. You define, in settings, which readings are
similar enough to constitute an input event.

•

Interval events are logged when the user-defined
logging interval has ended. Interval events can be
thought of as a series of readings divided into
sections by time. See Figure 2.

Documenting Software
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Input events are useful for detecting anomalies in a group
of data, when monitoring a process or when
troubleshooting a problem. Interval events are useful if
the values you record are fairly stable in nature and your
main purpose is documentation for record keeping.
If the values you record are fairly stable, but monitoring
variance from the norm is critical, recording both interval
events and input events can be a valuable troubleshooting tool. The interval events serve as routine
documentation, while the input events record any
significant changes that occur during the intervals.
By default, FlukeView Forms logs both input and interval
events. You can view either or both on the form. If you
decide to record only input events or only interval events,
you lose this flexibility, but you reduce the number of
readings you take and save disk space on your PC.

Note
See the FlukeView Forms Technical Notes for a
more comprehensive description of how event
logging is performed and how to effectively use it
for your purposes.

Setting Up Your Logging Session
From the Meter menu, open the Logging Window.
From the Logging Window, set up your logging session
by selecting the Setup tab. You can then customize the
default logging setup to collect your data.

Simulation Graph
Display Simulation Graph lets you view the effects of
changing the logging settings. It shows how an example
input is compressed into events with the current logging
settings. After you change the logging settings and click
the With Setup Data radio button, the Simulation Graph
updates to reflect your changes.
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Click on the << button if you want to change the example
input data to approximate the inputs you are expecting to
measure.

Changing the Input Event Settings

Changing the Logging Interval

Changing the input event settings allows you to specify
what changes in the input are significant enough to begin
a new input event.

To change the logging interval, open the Logging
Window, select the Setup tab and make changes in the
Interval section. Changing the logging interval:

To change event settings, open the Logging Window,
select the Setup tab and make changes in the Events
section.

•

Does not usually significantly change a graph of the
data. A very small interval (10 seconds or less) rarely
provides more significant data, especially if input
event data is also being recorded.

•

Does directly impact the number of records stored
(smaller interval means more records are recorded).

With Relative Threshold selected under Threshold
method, you specify a percentage change in the readings
that begins a new event. Relative thresholds work well
when signal noise (insignificant changes in the input
signal) is proportional to the expected signal value.

•

14

Does not change the number of times that FlukeView
Forms requests readings from the meter. This is an
internal value based on the type of meter and the
PC’s CPU speed and current performance.

With Fixed Threshold selected under Threshold
method, you specify a fixed-value change in the readings
(in the units of measure that the meter is using) that
begins a new event. Fixed thresholds work well when you
want to capture a significant unit change in the input you
are measuring.

Documenting Software
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If the meter supports internal event logging, you can
choose to have the meter perform the input event
detection. When the meter is performing the input event
detection, the input change detection is noticeably faster.
Note
With the exception of the Fluke 789: If your
meter supports the display of two readings at
once, and both are being displayed, you need to
select whether the input event thresholds are
applied to the primary or secondary display.

Viewing the Status of a Logging Session
Once logging starts, from the Logging Window, select
the Status tab to watch the current logging session as it
occurs.
The Recent Activity Chart graphically displays the most
recently logged events; the current event is yellow, while
older events are blue, and eventually scroll off the left
side of the chart.

Single-Reading Copy to Form
You can capture a single display reading from your meter
and copy it to a form for printing or saving. This is useful
when you only need the reading that appears on the
meter for your records.
To capture a single reading from your meter, the meter
must be connected to the PC. You may copy more than
one reading to the form, but the readings must be copied
one at a time.
The most common way to perform a single-reading copy
to form is to use the virtual meter window. Open the
virtual meter by clicking the Meter button at the top righthand portion of the toolbar.
Meters that support single-reading copy to form are listed
in Table 3.

The number of events logged and the current high, low
and average values for the event in progress are also
displayed in tabular form.
The active form also updates when an event closes.
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The drop-down list in the top left corner of the virtual
meter window gives you several options for viewing data.

The reading appears at the bottom of any display reading
table on the form, or in a testpoint reading form item.

•

The Primary/Secondary Readings option gives you
a small screen that reflects the meter display.

Data from Multiple Meters on a Single Form

•

The Meter Display option simply gives you a largerscreen view of this data. Both views allow you to use
single-reading copy to form.

To perform a single-reading copy to form:
1.

2.

Make sure the meter is connected to the PC. Check
the meter-connection icon on the lower-right corner
of the FlukeView Forms screen or the display on the
virtual meter.
Open the virtual meter by clicking the Meter button at
the top right-hand side of the toolbar.

3.

Set the virtual meter view to either
Primary/Secondary Readings or Meter Display.

4.

When the virtual meter displays a reading you want
to copy, click on Copy Into Form.

You can display data from more than one meter on a
single form. This allows you to compare data collected
from separate meters or from the same meter at different
times.
Use data groups to differentiate between data collected
from different meters. When you transfer meter data to a
form, specify the data group to associate with the data:
•

When uploading data from meter memory, select the
data group on the Get Meter Data dialog box under
Send data to group.

•

When interactively logging from the meter, select the
data group on the Logging Window setup screen
under Log to Data Group.

•

For copying meter data from the virtual meter to the
active form, you will be prompted for the data group
to associate with the data.

Each form item that displays meter data is set to a
particular data group, and displays the meter data
corresponding to that data group. (Logged Readings
Graphs can show data from multiple data groups on the
same graph.)
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To display multiple data groups on a form, the form
template you are using must be enabled for multiple data
groups. Otherwise, the form can only contain data from a
single meter. Use FlukeView Forms Designer to enable
data groups on a form template.
See the online Tutorial #4, “Multiple Data Groups,” for
step-by-step instructions on how to use data groups.
Note
Multiple data groups are not supported in
FlukeView Forms Basic form templates.

Using Forms
The form is the primary element of FlukeView Forms
documenting software. Each online form contains form
items, which display meter data or user-entered data.
Once you have transferred data from the meter to the
active form, you can enhance the presentation of data in
a number of ways.

Manually Adding User Data
Most form templates have form items designed for
information that is manually entered by the user. If you
place your cursor in a field and the symbol appears, that
is a user data field. You can enter comments and
additional data in these fields.

To retain user data when adding a new set of meter data:
1.

Press the Clear button.

2.

Choose Meter data only from the Clear Form dialog
box.

3.

Get the new meter data.

Formatting Data on an Existing Form
You can change the way data appears on an existing
form by altering the graphs and tables.
To alter graphs or tables, place your cursor inside the
graph or table and right-click. A menu of options for that
form item appears.
For instance, when looking at a graph, you can zoom in or
out and print or save various views of the graph to suit
your needs. This lets you highlight relevant data.
Or, you can select Add a Note from the Edit menu to add
a “sticky note” to the form. Position it to annotate the data
being displayed in a graph, a table, etc.; the Note will be
saved and printed with the form.
See the online Tutorial #2, “Formatting Meter Data,” for
step-by-step instructions on how to alter the appearance
of meter data on a form.
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Printing a Form
To print a form:

Saved forms are identified by the form template and the
date and time they were first saved. You can also enter a
30-character remark to help identify the form. The remark
is displayed after the date and time in the Saved forms
list at the top of your screen. See “Finding and Opening
Saved Forms” in this manual for more information.

1.

On the File menu, select Print. You can also use the
Print button.

2.

Sometimes, there is more meter data than the tables
on the form can display. Select Print tables at end
of print job to print all meter data in tabular form
immediately after the form is printed.

3.

Change printer, print range, or copy settings.

If the active form contains meter data, you can display the
same data in a different form template.

4.

Click OK.

1.

Select Copy Form Data from the Edit menu.

2.

Open the Select a form template drop-down list and
select a different form template. If you haven’t
already saved the form, a Save dialog box gives you
the option to save the data in your original form
template.

3.

A blank form is created from the form template you
selected.

4.

Select Paste Form Data from the Edit menu. The
meter data is pasted to the form.

Saving a Form
Saving a form stores all data and formatting on the active
form so that you can view the form at a later time. If you
do not save the form, all the data on the form is lost when
you transfer new data from your meter, change the form
template, or exit FlukeView Forms.
To save a form, from the menu, select File, then Save.
You can also use the Save button. Save is disabled if
there is no new data to save.
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Placing Existing Meter Data in a New Form
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Note

1.

User data must be re-entered when you move
existing data from one form template to another.

From the menu, select Tools, then Select Readings
to display the Select Readings tool.

2.

The Select Readings dialog box appears. Click Help
for instructions on deleting, reordering, or combining
readings.

Display Selected Readings
Sometimes, you might not want to display or save all of
the readings you have taken from the meter. The Select
Readings dialog box allows you to:
•

Delete unnecessary readings from the form.

•

Rearrange the order of display readings on the form.
If display readings are taken in the wrong order, they
show up in the wrong order on the display readings
table and testpoint readings form items. Select
Readings allows you to correct their order.

•

Combine multiple logged readings into a single
reading.
Note
You cannot edit the actual meter data. You can
only delete entire readings, or you can change
the order of readings.

See the online Tutorial #3, “Editing Data,” for further
instructions on using the Select Readings dialog
box.

Finding and Opening Saved Forms
If you save a form, you can access that form again at a
later time.

Opening a Saved Form
To open a form that you have saved previously:
1.

Open FlukeView Forms.

2.

In the Select a form template drop-down list, select
the template in which you saved the form.

3.

In the Saved forms drop-down list, browse to the
form and click to open.
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It is important that you select the template in which your
data was originally saved. The Saved forms drop-down
list only displays those forms that were saved in the
selected form template. If you do not remember the
template in which you saved the form, search for it using
the menu. From the menu, select File, then Open Saved
Form. You can also use the Find button to locate the
saved form.

Deleting Forms

1.

Highlight the form in the Saved forms drop-down list.

Using the Find Button to Find a Saved Form

2.

The Find button provides a more powerful way to locate
saved forms. Use it to list forms that match criteria you
establish.

From the menu, select File, then Delete Saved
Forms.

3.

Confirm your command to delete the saved form.

1.

Open FlukeView Forms.

2.

Click on the Find button.

3.

Fill in the criteria to search for forms. You can search
by form name, save date, or data type.

4.

Click the Find Now button.

Editing a Saved Form
You can edit forms you have saved previously by opening
the saved form and changing user data. You can then
either perform a Save to overwrite the original form, or
Save As to create a new form with the edited material.
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If you need to delete a previously-saved form:
Note
This action permanently deletes a saved form
and all the data it contains.

Exporting Data From a Form to a CSV
File
You can save meter data in a format that can be used by
other software applications. FlukeView Forms exports the
data to a comma-delimited file with a file name extension
of .csv. Optional output formats such as “Normalized
values” and “Separate units” for graphing numeric
analysis are available.
1.

On the File menu, select Export Data. The Export
Data dialog box appears.

2.

Assign a file name and select the Type of meter
data to export.

3.

Click Save to copy the data to the file.

Documenting Software
Virtual Meter

Virtual Meter

Primary/Secondary Readings

The virtual meter is useful if you want to view meter data
before adding it to a form. It allows you to preview
uploaded data, to export and copy data, and to copy a
single reading to a form.

Provides a compact, virtual representation of readings as
they occur on your meter’s display. If your meter displays
both primary and secondary readings, the virtual meter
shows both readings. You can perform a single-reading
copy to form in this view.

To open the virtual meter, click the Meter button on the
right-hand side of the toolbar.

Meter Display

Views
The virtual meter has three views for displaying data. The
display method(s) that are available depend on the meter
you are using.

Provides a large re-sizable view, virtual representation of
readings as they occur on your meter’s display. You can
perform a single-reading copy to form in this view.

Functions

Memory

Preview Uploaded Data

This view shows the data uploaded from meter memory.
For some meters, a “session” list may be displayed to
allow the user to select which set of data to upload to the
form. Generally, you can copy the data to the form or
export the data to a csv file (see file export for a more
flexible export). Additional buttons/options are provided to
support specific meter capabilities. It shows meter data in
tabular form for you to view before placing it in the active
form.

The virtual meter allows you to preview data in tabular
form before you place it in a form.
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Export Data

Clearing Data from Meter Memory

You can export uploaded meter data as a .csv file by
doing the following:

You can use FlukeView Forms to clear data from the
meter’s memory, if the meter supports it.

1.

Transfer data from meter memory to FlukeView
Forms.

2.

To open the virtual meter, click the Meter button on
the right-hand side of your display.

To find out how to do this, see this topic under the section
entitled “FlukeView Forms Meter Functions” in this
manual.

3.

Select the Memory view.

4.

Click on the Export button.

5.

Assign a file name and click Save.
Note
This export provides a quick, what you see is
what you get, export. For a more flexible export,
see the File Export Data menu.
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Single-Reading Copy to Form
You can capture a single testpoint reading from your
meter and copy it to a form for printing or saving.
To find out how to do this, see this topic under the section
entitled “Getting Data from the Meter to the PC” in this
manual.
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Managing the Database

By default, FlukeView Forms databases have the file
name extension .fdb.

FlukeView Forms stores all meter data, user data and
forms in FlukeView Forms databases.

Creating a New Database

You can change the active database and create new
databases in FlukeView Forms and FlukeView Forms
Designer.

To create a new database:
1.

Open FlukeView Forms or FlukeView Forms
Designer.

2.

On the menu, select File, then New Database.

3.

Name the new database and click OK.

4.

Select the form templates you will want to copy into
your new database.

Note
The FlukeView Forms Designer is not available
in FlukeView Forms Basic.
You should create new databases as your database
grows larger. Storing all the data you collect into a single,
large database can lead to poor performance. Instead,
store your data in several smaller FlukeView Forms
databases, with similar data stored together. You can also
copy forms from one database to another.

Opening Databases
To open a different database:
1.

Open FlukeView Forms or FlukeView Forms
Designer.

By default, FlukeView Forms databases have the file
name extension .fdb.

Backup Procedures
To back up the database:
1.

Open FlukeView Forms Designer to a blank form.

2.

On the menu, select File, then Open Database.

2.

On the File menu, select Open Database.

3.

Select the database to back up and click OK.

3.

Browse to the drive and folder containing the
database.

4.

On the menu, select Advanced, then Database
Maintenance.

4.

Select the database you want to open and click OK.

5.

Select Backup and follow the on-screen instructions.
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Note

Copying a Form To Another Database

FlukeView Forms Designer is not included in the
FlukeView Forms Basic product.

You can copy a saved form, including all of the meter
data and user data stored with it, to another database.
1.

Open FlukeView Forms, and view the saved form
you wish to copy.

2.

On the menu, select File, then Export Form.

3.

Select the database you want to copy the form to; or
type in a new database name to create a new
database containing only this saved form.

4.

Click OK.

Optimizing the Database
To improve performance, optimize your FlukeView Forms
database.
1.

Open FlukeView Forms Designer to a blank form.

2.

On the menu, select File, then Open Database.

3.

Select the database to optimize and click OK.

4.

On the menu, select Advanced, then Database
Maintenance.

5.
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Select Optimize and follow on-screen instructions.

Program Options
From the menu, select Tools, then Options to:
•

Change default program options for the active form.

•

Change communications options.

Changing Program Options
You can change the default options for the active form, as
well as change some of the communications options.
1.

On the Tools menu, select Options. The Options
dialog box appears.

2.

Use the Communication tab or Preferences tab to
change the appropriate options.

FlukeView Forms Meter Functions
You can change some meter settings from FlukeView
Forms.

Documenting Software
Altering Form Templates

Clearing Data from Meter Memory

Changing Meter Settings

Use FlukeView Forms to clear data from meter memory.

You can use FlukeView Forms to change some meter
settings, including synchronizing the clock, internal
logging settings and other meter functions that are
specific to the type of meter.

On meters that allow you to save several types of meter
data to meter memory, FlukeView Forms prompts you to
select which type to clear.
To clear data from meter memory:
1.
2.

On the Meter menu, select Clear Meter Memory.
The Clear Meter Memory dialog box appears.
Click OK to confirm.

1.

Turn on the meter.

2.

From the Meter menu, select Change Meter Setup.

3.

Make changes to the dialog box.

4.

Click Send to change the meter settings.

Altering Form Templates
You can alter the form templates provided by FlukeView
Forms or you can create new templates using FlukeView
Forms Designer.
See the online Tutorial #1, “Creating a Customized Form
Template,” for detailed instructions on how to alter and
modify form templates.
Note
FlukeView Forms Designer is not included in the
FlukeView Forms Basic product.
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Altering an Existing Template
1.

Open FlukeView Forms Designer.

2.

Open an existing form template.

3.

Enable or Disable data groups by selecting Layout,
then Data Groups. Click Help for detailed
instructions.

4.

Click on any form item, then click and drag its border
to move it to a new location.

5.

Add new form items from the menu by selecting Edit,
then Insert Form Item. Highlight the form item name
and click Insert.

6.

Delete an existing form item by selecting it (click on
the form item in the form template). From the menu,
select Edit, then Delete Form Item.

7.

Change fonts, type colors and other form-item
characteristics by selecting the form item (click on the
form item in the template). From the menu select
Edit, then Properties. Make changes.

8.

Select multiple form items by holding the Ctrl or Shift
key down while clicking on the form item. Then align
or resize form items to one another by selecting
Align Form Items or Resize Form Items under the
Edit menu.

26

9.

Align or resize form items to the grid by selecting
Snap to Grid or Shape to Grid from the Edit menu.
To change the grid spacing, select View, then Grid
Lines.

10. Save the form template in one of the two following
ways:
•

with a new template name by opening the File
menu, and selecting Save As; or

•

overwrite the active template by opening the File
menu and selecting Save.
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Creating a New Form Template

Form Items

1.

Open FlukeView Forms Designer. The screen should
be blank. If not, on the menu, select File, then New.

2.

Enable or Disable data groups by selecting Layout,
then Data Groups. Click Help for detailed
instructions.

Each form template contains form items, which display
meter data or user data. Form items displaying meter
data can only display either logged readings or display
readings.

3.

Add new form items from the menu by selecting Edit,
then Insert Form Item. Highlight the form item name
and click Insert.

4.

Move the form item to its proper location on the form.

5.

Change fonts, type colors and other form-item
characteristics by selecting the form item (click on the
form item in the template). From the menu select
Edit, then Properties. Make changes.

6.

Once the form template is complete, save it with a
new template name from the menu by selecting File,
then Save As.

The following is a list of available form items. These are
found in templates and can be incorporated into designed
forms.
Some form items can only be used by certain meters. Get
a list of form items for your meter by selecting the Edit
menu, then Insert Form Items. In the drop-down list for
Display Form Items for Meter, select your meter.
FlukeView Forms displays only the form items that your
meter can use.

Logged Readings Form Items
Logged Readings Graph
Provides a graphic representation of the logged readings
recorded during a logging session. Data from multiple
logging sessions can be viewed on the same graph, with
a variety of formatting options.
The horizontal axis shows the time and the vertical axis
shows a scale for the logged reading values.
Logged Readings Table
Displays logged readings in table format. Initially, this
table lists the logged reading values that are grouped in
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the logged readings graph. Can display input event data,
interval event data, or both.
Logging Summary
Displays the following information about a logging session
on the form:
•

Logging session information: start, stop, and elapsed
time; interval length; number of readings; scaling
factor; and other meter-specific data.

•

Summary information: the maximum, average, and
minimum logged readings.

Event Amplitude Histogram
Graphically shows the distribution of logged readings by
their amplitudes (values). This is often useful when the
logged readings fall into several discrete levels.
Event Duration Histogram
Graphically shows the distribution of logged readings by
their duration (length).
Event Scatter Graph
Graphs the duration of logged readings against their
amplitude. Typical readings tend to plot together in a
cluster, whereas exceptional events are plotted away
from the typical ones. This can be useful when there is a
recurring event.
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Note
Some of the information displayed depends on
the type of meter you are using.

Display Readings Form Items
Display Readings Table
Presents display readings in table format. The display
readings table maintains the original unit of measure. The
table can be extensively customized, and columns may
be added for entering comments about individual
readings.
Testpoint Reading
Displays a single display reading on the form. The display
reading may be scaled. The row number of each display
reading in the display reading table corresponds to the
reading number associated with each testpoint reading
form item. The source reading generally corresponds to
the column number of the reading.
Note
Testpoint Reading does not support Fluke 1653
or 1550B readings.
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Meter ID and Date Form Items
Date Time Stamp
The time stamp is automatically updated to your
specifications the first time a form is saved, when meter
data is received, or when the form is modified.
Meter Identification
Displays the serial and/or model number of the meter that
was used to transfer the meter data.

User Data Form Items
Memo
Provides a space (up to a maximum of 64,000 characters
and 1000 lines) for adding user comments and notes. You
can use the text in the memo when searching for forms
with the Find button.
Check Box
Use the check box form item to record a yes or no
response. Selecting the check box form item signifies
Yes. Clearing the check box signifies No.

Numeric Entry
Provides a space to type numeric values on the form.
Selection Box
Allows you to choose data from a list of predefined values
that are set up when you design the form template. You
can also add values to the selection box when you enter
data. You can use the text in the selection box when
searching for forms with the Find button.

Static Form Items
Static form items are those items that can only be
modified in FlukeView Forms Designer.
Counter
The counter form item displays a unique incrementing
number on saved forms. Each time you save a form that
contains a counter form item, the counter form item is
incremented from the last time that form was saved.
If a form contains a counter form item, saving it causes it
to increment or decrement as specified by you when you
create the form template.
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Bitmap
A static graphic image, such as a company logo. Bitmap
image formats include:
•

Graphics Interchange Format (.gif) files

•

JPEG File Interchange Format (.jpg) files

•

Windows Bitmap (.bmp) files

Label
This item displays static text on the form.

Troubleshooting
For other troubleshooting issues and up-to-date
information, see the FAQ and technical notes at
www.fluke.com.

Setting the Comm Port
To change the communications port that FlukeView
Forms uses:
1.

On the Tools menu, select Options. The Options
dialog box appears.

2.

Click the Communications tab.

3.

In the Port drop-down list, select the communications
port you would like to use. The default
communications port for FlukeView Forms is COM1.
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4.

Click OK.
Note
The current communications (COM) port is
displayed at the bottom right of the FlukeView
Forms screen. Double-clicking on this will bring
up the Options dialog.

Testing the Cable Connection
To test the meter connection:
1.

On the Tools menu, select Options. The Options
dialog box appears.

2.

Click the Communications tab.

3.

Press the Search button on the right-hand side to
test the cable connection.

